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1. Introduction 
 

EndNote is one of a number of Personal Reference Database programs that are available today. The 

main functions of such programs are: 
 

 Maintenance of a personal database of references.  

 Downloading references from other databases. 

 Using the personal database to insert references in word-processed documents.  

 Generating a bibliography in the correct style for publication.  

 

The University of New England has negotiated a site licence for EndNote, which permits all UNE 

staff, higher degree, postgraduate and Honours students (including those in LS 400, RUSC 490, NR 

490 and GEPL 455) to use the software both at work and at home. For information on how to obtain 

and install the software, see UNE Library‟s EndNote support website at: 

www.une.edu.au/library/support/endnote/index.php 

This guide aims to show you the basic skills required to get started using the latest version of 

EndNote. It does not cover everything you will ever need to know.  The help screens in EndNote are 

very useful and they can be accessed by clicking on the Help option on the menu bar at the top of the 

screen or the Help button  on the toolbar of your EndNote library. There is a printable version 

of the Help, although it is over 400 pages long. 

 

There is also a useful Getting Started guide (around 100 pages), which is a PDF file installed on 

your computer in the same folder as your EndNote software. You can access it easily from the 

Windows Programs menu or on the EndNote website at 

http://www.endnote.com/support/helpdocs/ENX5_GettingStartedGuide_MacWin.pdf. 
 

Assistance can also be obtained from the Library's Ask a Librarian at: 

www.une.edu.au/library/support/ask-a-librarian.php 

For more complex problems, you can contact the staff at EndNote via the web at: 

www.endnote.com/support/entechform.asp 

In this guide we use the Windows operating system. EndNote X5 is compatible with Windows XP 

(with Service Pack 3), Vista and Windows 7. For Windows system/hardware requirements and word 

processor compatibility go to http://www.endnote.com/enwin.asp. 

 

EndNote is also available for Macintosh for OS X versions, and it operates in a similar way to the 

Windows software. Check details on Macintosh system/hardware requirements and word processor 

compatibility from http://www.endnote.com/ENMac.asp. 
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2. Opening EndNote 

 

After installing EndNote locate the EndNote Program icon on your Start menu or desktop. 

 

Click on the EndNote Program icon. If this is the first time you have used EndNote, you should see 

this dialogue box: 

 

 
 

Initial Dialogue Box 

 

 

What is an "EndNote Library"? 

 
"Library" is the term used by EndNote to describe a file where you have stored a 

database of references. A library can contain up to 100,000 references. 

 

Multiple libraries can be maintained, but generally there is no need to do this. All 

references can be kept in the one library, and labelled or grouped to reflect any 

particular subject interest. We strongly recommend that you maintain one library 

only. 

 

You can set up a default library, which will open automatically when you open 

EndNote. To do this, select: Edit>Preferences>Libraries 

 

Once you have set up a default library, you will no longer see the introductory 

dialogue box. 
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3. Setting Up a New Reference Library 
 

Click the Create a new library graphic. 

 

You will see a dialogue box like this, with My EndNote Library.enl as the name of the new library: 

 

New Library Dialogue Box 

 In the Save in box, select the folder where you wish to save the library. 

 In the File name box, type a name for your library. 

 Click on Save. You should see a new library window, like this: 
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The Tab Pane at the bottom of the library window will show you what your formatted references 

look like. It is also used for searching your library or a remote database. To close the Tab Pane, click 

on Hide Tab Pane. 

 

The Groups Pane at the left of the library window allows you to organise your references into 

groups. You can close the Groups Pane by clicking on the Groups option on the top menu bar and 

selecting Hide Groups. 

 

 

More about EndNote libraries 
 

The file extension .enl stands for EndNote Library. A library is just a file on your 

computer, like any other file. It can be copied, renamed, deleted, moved to another folder 

or compressed.  

 

It is very important to make back-up copies of your library regularly and store them on 

another drive. An easy way to back-up your library is to go to the File option on the 

menu bar, and select Compressed Library. 

 

When EndNote creates the library, it will also create a .DATA folder which contains 

various files connected with the library. When you compress the library, EndNote will 

include the .DATA folder. 

 

A compressed library can be uncompressed by using the File>Open command. 

 

The library window can be resized or maximised, like any other window. 

 
 
4. Using the Toolbars 

Note the toolbar at the top of the library window. If you position your mouse over any of the buttons 

on the toolbar, a text box will appear showing the name of the button. 

When we start inputting references, you will see that the window for each reference also has a 

toolbar. 

 

Do I have to use the toolbars? 

 
All the commands on the toolbars can be accessed from the menu bar at the top of the 

screen, if you prefer to work that way. The toolbars give you faster access to the most 

common commands. 

 

In this guide, we will use the toolbars.  

 

5. Choice of Mode 

There are three modes of searching EndNote, using the first three icons on the toolbar: 

      The first icon is the Integrated Library & Online Search Mode. This is used to 

search outside databases from within EndNote so you can download references directly into your 

EndNote library. This is not usually recommended as it does not work for many of the UNE 

databases and you can be using the internet without realising it. 
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Another option is to mostly work in Local Library Mode      and switch to        

Online Search Mode      when you want to search online from EndNote and 

download references into a temporary library. This works well, as you can download references 

without affecting your Local Library. 

6. Inputting References Manually 

Find a journal article which is relevant to your research and use this to practise inputting references 

manually.  

Click on the New Reference button      on the library toolbar. You should now see a New 

Reference window: 

 

New Reference Window 

Note that Journal Article is the default Reference Type. 

 

Click on the arrow at the right of the Reference Type box to see the other reference types (e.g. Book, 

Conference Proceedings, Map, Web Page, etc.) 

 

With Journal Article as the option in the Reference Type box, input the details for the article. Use 

the Tab key to go from one field to the next, or click in the next field with your mouse.  

 

When you have finished typing the data for your reference, it should look something like this: 
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Reference for a Journal Article 

Close the reference by clicking on the X button in the top right-hand corner of the New Reference 

window. Closing also saves the reference. 

Practise inputting a reference for a book. 

Remember to select the appropriate Reference Type, and then input the data. 

After inputting the data, Close the reference. 

A reference for an edited book should look something like this: 

 

Reference for an Edited Book 
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"Garbage In, Garbage Out" 

Later you will learn about the EndNote output styles. These convert the data in your library 

into formatted references. The output styles can only format your data correctly if you have 

entered the data correctly in your library. 

 

Here are some important points to remember when entering data: 

 

 If there is more than one author, each author must be entered on a separate line. 

 Corporate authors must be entered with a comma at the end, e.g. Queensland Health, 

 Just add the basic data, in the default EndNote font. The output style will change this to 

bold or italics (if necessary) and add extra text such as "vol." or "Ed." (if required by the 

style). 

 Fields such as Abstract, Notes, Research Notes are for your use. These fields can each 

store up to sixteen pages of text. 

 Use the URL field to link to an electronic version of the document on the web. 

 Use the File Attachments field to link to a PDF version of the document stored on your 

own computer. 

 If you use abbreviated journal titles in your publications, you can set up a Journal Term 

list to store the abbreviations. There is more information in the Help screens and on the 

UNE Library EndNote website at 

www.une.edu.au/library/support/endnote/journal_abbreviations.php  

7. Editing References in EndNote 

In the library window, double-click on one of the references that you have entered. This will open it 

for editing. 

You can change any of the details. For example, add some text to the Notes field. Close the 

reference when you have finished editing and this will save the changes. 

Alternatively, to make a small change quickly, you can click on the reference once to highlight it, 

and then click on the PDF & Quick Edit tab in the tab pane at the bottom of the Library window. 

If you want to delete a reference from your library, click on it once in the library window to select it, 

and then go to the References option on the menu bar, and select Move References to Trash. 

8. Grouping References 

Once you have entered a significant number of references into your library, you may find it helpful 

to group them by subject. This is a much better option than setting up separate libraries for each 

topic. 

To set up a group, click on Groups on the top menu bar, and select Create Group from the drop-

down menu. This will open a box in the Groups Pane on the left-hand side of the library window, 

where you can type a name for the group. 
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Creating a New Group 

To add a reference to a group, make sure that you have selected All References in the Groups Pane. 

Highlight the reference in the library window. Click on Groups on the top menu bar, click on Add 

References To from the drop-down menu, and then select the name of the group. 

 

 

Adding a Reference to a Group 
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More on groups 

 

You can also add references to groups by right-clicking on the reference and selecting 

the group, or you can drag-and-drop the reference onto the group name in the Groups 

Pane. 

 

You can have up to 500 groups in your library. 

 

You can set up smart groups. These groups have an inbuilt search query. When a new 

reference is added to your library, it is checked against the search query. If it matches, it 

is automatically added to the smart group. 

 

For more sophisticated grouping, you can organise your groups into group sets. 

 

 

9. Direct Export from a Database to EndNote 

 

 

What is "direct export"? 
 

When you are searching certain databases via the web, you will find that they allow you 

to select records and then send them directly to your EndNote library. This is called 

"direct export". 

 

Direct export will only work if you are using Internet Explorer or Firefox as your web 

browser. 

 

With some databases, such as Web of Science, this feature works very well. However, 

with certain databases you will find that the records do not import accurately and need to 

be edited after import. 

 

 

Use your web browser to display the UNE Library Database list at: 

www.une.edu.au/library/find/databases.php 

Locate the listing for Web of Science under Most popular databases and click on it. Note that, 

despite the name of this database, it contains references in all subject areas. Do a keyword search. 

 

When the first page of results is displayed, click in the boxes beside some of the references to "mark" 

those references. Now click on the button labelled Save to EndNote, RefMan, ProCite.    

 
 

This will activate the direct export process. Depending on your browser, you may see a dialogue box 

asking you what to do with the references. If so, you should choose to open the file. EndNote uses a 

helper application called ResearchSoft Direct Export Helper to import the references into your 

EndNote library. 

 

In the library window you will see only the references which you have just imported. They have been 

placed in a temporary Imported References group. To see all references in your library, click on the 

All References group in the Groups Pane of the library window. 

 

You can return to Web of Science and go to the next screen of results and import further references 

to EndNote. Always export the references before moving to the next screen of results. 
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10. Importing Downloaded References with a Filter 

 

 

 

What is a "filter"? 

 
A filter is a piece of software that will take a file of references which have been 

downloaded from a database and convert them into references in your EndNote library. 

 

The file of references must be in plain text (*.txt) and must be split up into labelled 

fields, something like this: 

 
AU: Smith, J. 

TI: New developments in instructional software 

SO: Journal of Educational Technology, vol. 3 (2001): 305-

318 

 
A filter is specific to a particular database (e.g. Medline, PsycINFO). When the 

database is marketed by more than one vendor, different filters will be required for 

each vendor's version of the database (e.g. Medline from Ovid, Medline from Ebsco, 

and Medline from ProQuest). 

 

 

Use your web browser to display the UNE Library EndNote Filters page at: 

www.une.edu.au/library/support/endnote/filters.php 

Most databases offer direct export to EndNote, but for others you need to use a filter. Many filters 

are supplied with your EndNote software but the filters listed on the UNE filters webpage are not. If 

you use those databases for your research you will need to download their filters by double-clicking 

the yellow „Link‟ folder and choosing „Save‟. 

 

When downloading a filter, you must save it in your EndNote filters folder. The default location of 

the filters folder is: 

C:\Program Files\EndNote\Filters (for Windows XP and Windows 7) 

For Windows Vista „Open‟ the filter instead of „Save‟. The filter will open in EndNote. Go up to File 

> Save as, give the filter a name and it should save in the correct place. 

 

Check the UNE Downloading from databases page  

www.une.edu.au/library/support/endnote/downloads.php 

and find out how to move references from a particular database into your EndNote library. 

 

Use your web browser to display the UNE Library Database list at: 

www.une.edu.au/library/find/databases.php 

Open your chosen database. Perform a search and select some useful references.  

Using the instructions from the Downloading from databases page, download the references in the 

correct format for import to EndNote. An EndNote filter can only import a plain text file (*.txt). 

Save the downloaded references in any convenient folder. 

Return to EndNote, and make sure that your library is open. 
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Click on the Import Button      on the library toolbar. You should see a dialogue box that looks 

like this: 

 

Import Dialogue Box 

Now click on the Choose File button. Locate and select the file of references that you downloaded.  

In the box labelled Import Option, click on the down arrow to see some of the standard import 

options. Then click on Other Filters to open the list of filters: 

 

Filters List 

Browse down the list of databases until you find the filter which you downloaded.  

Highlight the filter and click on the Choose button. This will return you to the previous dialogue 

box.  

Next, in the Duplicates box, select Import into Duplicates Library.  

 

In the Text Translation box, the default option No Translation is appropriate in most cases. The 

dialogue box should now look something like this: 
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Import Dialogue Box 

 

Click on the Import button and the references should be imported. In the library window you will 

see only the references which you have just imported. They have been placed in a temporary 

Imported References group. To see all the references in your library, click on the All References 

group in the Groups Pane of the library window. 

 

 

 

More on filtering references 

 
No filter is perfect, and all references should be checked after import. For this reason, 

it is often better to import references into a temporary library, and leave them there 

until they can be checked against the file of downloaded references and amended. 

They can then be copied to the permanent library. 

 

 

11. Importing PDF files 

You can import a PDF file in the same way you imported the text file of references. EndNote will 

create a reference for the article, attach the PDF and store the article in your Data folder. 

Click on the Import Button      on the library toolbar. In the dialogue box that appears use 

Choose to find where your PDF document is saved. For your Import Option choose PDF (instead 

of a filter) and keep your Import into Duplicates Library option. Your dialogue box should look 

something like this: 

 

Importing PDF dialogue box 



 13 

Note: To create the reference with information in the correct fields the PDF must have a DOI 

(Digital Object Identifier). This is like a unique address for the article. DOIs have been consistently 

allocated since 2000 so you may find that older articles do not have one. If this is the case, EndNote 

will create a blank reference and attach the PDF document. You will need to fill in the details 

manually. 

You can also import a folder of PDFs by going to File, down to Import and clicking on Folder. 

12. Find Full Text 

EndNote can automate the task of locating full text files (if available) on the web by using 

bibliographic data stored in the reference. Once found, EndNote downloads and attaches the PDF to 

the reference. 

Make the following changes to your EndNote settings to set up your EndNote so that it can look for 

full text owned by the UNE University Library. Find Full Text works best when you are looking for 

journal articles or conference papers, not books. 

Open your EndNote software and go to Edit >Preferences >Find Full Text 

 Check the box for ISI, DOI and OpenURL. Leave the PubMed box unchecked unless you are 

interested in the biological and medical sciences. This will make the search much faster. 

 Type in the OpenURL Path: http://GR6MD6KU7C.search.serialssolutions.com 

 Type in the Authenticate with URL: https://ezproxy.une.edu.au/login?url= 

 Click Apply and then OK 

  

Editing Find Full Text preferences 

To Find Full Text for a particular journal reference: 

 Select a reference (or a number of references) 

 Go to References in the top tool bar > Find Full Text > Find Full Text 
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 Log in with your UNE username and password and initially you may see a list of UNE 

databases. Click the Continue button. 

 Agree to the copyright disclaimer by clicking Yes. 

 Look under the Find Full Text heading at the bottom left column of your EndNote Library. 

This will indicate the progress in Searching and the software will then tell you if the article 

has been found successfully or not found.  

 

 Full text articles will be attached automatically to the relevant records. If EndNote cannot 

download the PDF article it may provide a URL link so you can retrieve the article yourself. 

13. Connecting Directly to Databases via the Internet (Online 
Search) 
 
 

 

What is a "connection file"? 

 
A connection file is a piece of software that allows you to search a database over 

the Internet, without leaving EndNote. You can then select references from the 

database and import them directly into your EndNote library. 

 

Connection files only work with databases which support a particular search 

protocol called Z39.50, so not all databases can be searched using a connection 

file. Many Library catalogues, including UNE‟s, are Z39.50 compliant. 

 

 

At UNE we are unable to connect to databases using connection files.  The two most pressing 

arguments against the use of connection files are: 

 There is a significant loss of functionality when searching databases using connection files; and 

 Firewalls have an inconsistent and detrimental effect when accessing databases using 

connection files. 

 

14. Searching an EndNote Library 
 

At the end of the toolbar at the top of the library window is the Quick Search box. You can type 

some text here, and EndNote will look for those letters anywhere in the library. 

 

EndNote also provides a more sophisticated search function. We will practise using this, searching 

the Sample Library which is provided with the software. Firstly, use File > Open to open your 

Sample Library. 

 

If the Tab Pane at the bottom of the library window is not open, click on Show Tab Pane. In the Tab 

Pane, click on the Search tab to display the Search dialogue box. We are using it to search an 

EndNote library. 
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Type the word sediment in the first search box. Make sure that the Field box is showing Any Field: 

 

 

Searching an EndNote Library 

Note that we have not checked the Match Words box. This means that we are searching for the 

string of letters sediment and not just for the word sediment. 

 

Click on the Search button. 

 

The results of your search will be displayed in the main part of the library window. Note that these 

include references containing words like sedimentary and sedimentology. This is because we did not 

check the Match Words option in the search dialogue. 

 

Let‟s do a slightly more complicated search. Assume we wish to find all references by the author 

Jones that were published after 1990. This means that we wish to find references which have jones in 

the Author field, and a number greater than 1990 in the Year field.  

 

Go back to the Search dialogue in the Tab Pane. In the first search box, click on the first arrow to 

select the Author field, and then type jones as the search term. 

 

At the beginning of the next row, make sure that And is selected as the Boolean operator. 

 

In the box beside it, use the arrow to select the Year field. In the box beside that, use the arrow to 

select Is greater than. Enter 1990 as the search term. The screen should look like this: 
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Constructing a Complex Search of an EndNote Library 

 

Click on the Search button and you should retrieve a result. The name Jones does not appear as a 

first author. Open the reference, however, and you will find that it has Jones as a collaborating 

author. 

15. Sorting an EndNote Library 

When you open a library, it automatically sorts itself alphabetically by author. However you can sort 

your references on any of the fields in the record, e.g. author, title, year, label.  

 

We will sort the Sample Library by year of publication, with the most recent references appearing 

first. Make sure you can see the complete contents of the library by clicking on All References in the 

Groups pane. 

 

Click on the column-heading Year near the top of the library window. This will sort the references 

with the oldest references appearing first. If you click on Year again the order is reversed. Now the 

most recent references appear first. 

 

More complex sorting is possible. Click on Tools on the top menu bar, and select Sort Library. This 

will display a dialogue box where you can select fields. The following screen will appear: 
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The "Sort Options" Dialogue Box 

In the first box, click on the arrow to select Year. 

At the end of the box is a button which indicates whether you wish to sort items from smallest to 

largest      or from largest to smallest   . Click on this button to change it to sort from 

largest to smallest, i.e. from most recent year to earliest year.  

In the second box, click on the arrow to select Author and leave the default setting to sort from 

smallest to largest, i.e. from A to Z. This means that after EndNote has sorted the references by year, 

it will sort them within each year alphabetically by author.  

The box should now look like this: 

 

Specifying the Sort Options 

 

Click on the OK button and the references in the library will now be sorted chronologically, with the 

most recent references first, then alphabetically by author.  
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16. Producing a Bibliography or Reading List 

What is an Output Style? 

 
An EndNote output style (often just referred to as a "style") is a piece of software that 

will convert the data in your library into formatted references that correspond to the 

bibliographical styles used by journal publishers or specified in style manuals such as 

the Chicago Manual of Style. 

 

A range of output styles is supplied with the software, and hundreds more styles can 

be downloaded from the EndNote website, so there is a good chance that you will 

find one suitable for your needs. If not, EndNote allows you to create your own 

output styles or edit an existing output style. 

 

We will now look at using EndNote to produce bibliographies. This is how you use the references in 

your library to generate a reading list for students, or a list of references for a colleague, or perhaps a 

list of your own publications for your CV. 

While holding down the Ctrl key, select about five references from your library.  

Click on References on the top menu bar and then click on Show Selected References. You should 

now be able to see only those references which you selected.  

Now you have to decide on the Output Style that you wish to use for your references. Go to the style 

menu      on the library toolbar and click on the arrow. You will see a list of the 

four basic EndNote styles. Click on Select Another Style to open the complete list of output styles 

which are supplied with the EndNote software: 

 

Output Styles List 

 

Find a style that would be useful in your subject area, and then click on it to highlight it. Click on the 

Choose button to select that style. 
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This will return you to the library window, with only your selected references showing. To generate 

a bibliography from these references, using the style that you have just selected, click on the Export 

button     on the library toolbar. 

You will now see a dialogue box. Save the exported references to a convenient folder. In the Save as 

type box, click on the arrow to select Rich Text Format. In the Output Style box, make sure that 

your chosen style is selected: 

 

Exporting a Bibliography 

Click on the Save button.  

 

To view the bibliography, open your word processor and then open the file which you have just 

saved. 
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17. Using EndNote with a Word Processor 
 
  

 

Is my word processor compatible with EndNote X5? 

 
For Windows users, EndNote X5 is compatible with 2010 (32/64 bit), Word 2007 and 

Word 2003, using Cite While You Write (as explained below). Cite While You Write is 

also compatible with Open Office.org Writer version 3. If you are using an earlier version 

of Word, or another word processor (such as WordPerfect), you must save your 

documents in Rich Text Format and use the Format Paper function (as explained in the 

EndNote help in your software). 

 

For Macintosh users, EndNote X5 is compatible with Word 2008 and Word 2011 (not 

Word 2004) using the Cite While You Write toolbar (as explained below). EndNote is also 

integrated into Pages 09, with similar functionality to Cite While You Write. If you are 

using an earlier version of Word, or another word processor, you must save your 

documents in Rich Text Format and use the Format Paper function (as explained in the 

EndNote help in your software).  

 

 

 

We have just seen how to use EndNote to create an independent bibliography, but EndNote can also 

work in conjunction with your word processor, so that you can insert references as you type a 

document, and automatically generate the bibliography. 

 

If you have a compatible version of Microsoft Word (Windows or Macintosh) installed on your 

computer, when you install the EndNote software extra files will be inserted into your word 

processing software. These files make up the Cite While You Write add-in. The appearance of the 

EndNote tools in Word will vary, depending on the version of Word which you are using. In this 

guide, we are using Word 2007. 

 

If you are using Word 2003, the EndNote commands appear on a toolbar in Word. Generally they 

work the same way as the EndNote commands on the Word 2007 ribbon. 

 

In Word 2007 you will see an EndNote tab on the ribbon. Click on the EndNote tab to see the 

EndNote tools: 

 

 
 

The EndNote Tools Menu in Microsoft Word 2007 

 

We will now practise using Cite While You Write by adding some references to a sample paper. You 

can use any Word document to practise this. Insert references from the library you have already 

created, or use the Sample Library. 
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a. Formatting References in an Author-Date Style 

What is an "author-date style"? 

The Harvard Style is the best-known author-date style, but there are many variations. In 

the text of the paper, the reference is cited in an abbreviated form similar to “… (Smith, 

1993)".  In the list of references at the end of the paper, references are given in full and 

listed alphabetically by author. 

Open your Word document.  

First you need to select the output style. We will practise using the APA style. To change to APA, go 

to the styles manager on the ribbon and choose Select Another Style: 

 

Styles Manager in Word 

This will display the complete list of styles. If necessary, click on the Name bar to sort the list by the 

name of the style. Then browse down to APA 6
th

, highlight it and click on the OK button, as shown: 

 

 

Selecting an Output Style 

 

Now start inserting references. Go to the end of the first sentence of your document, where we will 

insert our first reference, and insert a space before the full stop. 

Click on the Insert Citation button    on the ribbon. This opens a search window.  

Think of a reference which you wish to cite from your library. Enter the author‟s name in the search 

box, and click on the Search button. EndNote will display the matching references: 
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The "Find Citations" Search Window 

Highlight the required reference and click on the Insert button, and this reference will be inserted 

into your document.  

EndNote will instantly format the citation in the text and produce a list of references at the end of the 

document using the style which is currently selected.  

Your document might now look something like this: 

We still know very little about how researchers in many areas identify the 

information resources that they need (Broadbent, 1986). The available 

studies are often localised or discipline-specific. There is a clear and pressing 

need for further research in this area, and a need for detailed longitudinal 

studies that will help to identify emerging trends. 

Budd pointed out many years ago that there are fundamental differences in 

the research cultures of the sciences and the humanities. There is nothing in 

the more recent literature to suggest that his findings have lost validity over 

the years. On the contrary, it may well be that recent technological 

developments have increased these differences. 

References 
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We shall now add some more references to this paper. 

At the end of the second sentence in your Word document, insert a space before the full stop and 

again click on the Insert Citation button. Search for another reference, using the author's name or 

some words from the title. Select and highlight a reference, and click on the Insert button.  

Continue adding references to your document in this manner. As an alternative to using the Find 

Citations command, you can click on the Go to EndNote button    on the ribbon 

and select references directly from your library. Highlight a reference in the library window and 

return to Word. Then use the Insert Citation button on the ribbon and click on the arrow to choose 

Insert Selected Citation(s): 

 

Another option is to select references directly from your EndNote library, and use the Insert 

Citation button    at the top of the library window to insert the citation into your Word 

document. 

Save the changes that you have made to your paper. 

 
b. Formatting References in a Numbered Style 
 

 

 

What is a "numbered style"? 
 

In a numbered style, references are indicated by a number in the text. The number is 

often printed as a superscript. At the end of the paper, the references are given in full and 

arranged by the numbers which they have been assigned. 

 

Do not confuse a numbered style with a footnote (or endnote) style. With a 

footnote/endnote style, it is the footnotes/endnotes which are numbered. The references 

are then inserted into the footnotes/endnotes, along with other text. 

 

 

Using the paper that you have already formatted, we will change the style to a numbered style. This 

situation could arise if you decided to submit the article to a different journal. 

 

Use the styles manager on the ribbon (as explained above) to select another style. Choose the 

Nature style.  EndNote will reformat the paper in the new style. It might now look something like 

this: 
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We still know very little about how researchers in many areas identify the 

information resources that they need
1
. The available studies are often localised

2
 or 

discipline-specific
3
. There is a clear and pressing need for further research in this 

area, and a need for detailed longitudinal studies that will help to identify 

emerging trends. 

 

Budd pointed out many years ago that there are fundamental differences in the 

research cultures of the sciences and the humanities. There is nothing in the more 

recent literature to suggest that his findings have lost validity over the years. On 

the contrary, it may well be that recent technological developments have increased 

these differences. 
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Document with References in Nature Style 

Save the changes that you have made to your paper. 

 

 

c. Formatting References in a Footnote/Endnote Style 

 

Using EndNote with footnotes or endnotes is a little more complicated. See the FAQ on the UNE 

Library EndNote website at: 

www.une.edu.au/library/support/endnote/footnoting.php 

18. More on Formatting Documents 
 

We will now look at some special situations which may arise when formatting a paper with EndNote.  

a. Deleting a Citation 

To delete a citation, do not use the Delete or Backspace keys on the keyboard (with the exception of 

Notes in numbered styles – see below in 18b). 

 

To delete a citation safely, first highlight the in-text citation (i.e. the author and year in an author-

date style, or the number in a numbered style). Now click on the Edit & Manage Citation(s) button   

   on the ribbon and you will see the following dialogue box:  
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The "Edit Citation" Dialogue Box 

 

This will display all the citations in your paper. You will see the citations in EndNote's temporary 

citation format (first author, year, record number of the reference in your library). 

 

The citation which you selected should be highlighted. Click on the arrow on the Edit Reference 

button and select Remove Citation. Then click on the OK button.  

 

EndNote will remove the citation and reformat the list of references. Save the changes to your 

document. 

 
b. Including and Deleting Notes in the List of References 
 

This is only applicable to numbered styles. 

 

Some journals (such as Science) use a numbered reference style but permit you to include notes with 

the list of works cited at the end of the paper. In such a system, the notes are incorporated into the 

numbered list of references. 

 

To insert such a note in your Word document, first use the styles manager to select the Science style.  

 

Now position the cursor at the end of a sentence in the document and insert a space before the full 

stop. Then use the Insert Citation button on the ribbon and click on the arrow to select Insert Note: 
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You will now see a dialogue box, in which you can type your note. Enter the following text:  

 

These results are only preliminary. 

 

Then click on the OK button.  

 

EndNote inserts the note into the list of references. Save this change. 

 

Your document might now look something like this: 

 

We still know very little about how researchers in many areas identify the 

information resources that they need (1). The available studies are often 

localised (2) or discipline-specific (3). There is a clear and pressing need for 

further research in this area, and a need for detailed longitudinal studies that will 

help to identify emerging trends. 

 

Budd pointed out many years ago that there are fundamental differences in the 

research cultures of the sciences and the humanities. There is nothing in the 

more recent literature to suggest that his findings have lost validity over the 

years (4). On the contrary, it may well be that recent technological 

developments have increased these differences (5). 

 

 

Works Cited 
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Numbered Style with Note in List of References 

To delete this note, highlight the relevant number (4) in the text. Use the backspace key to delete the 

highlighted number and therefore the note. 

 

Note: This is an exception. In previous versions of EndNote you would use the Edit & Manage 

Citations function to delete a note, but there seems to be a bug in versions X4 and X5 which 

prevents you from doing this. 
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c. Adding Text before a Citation 
 

This is only applicable to author-date styles. 

 

Some styles allow you to add text before a citation in a paper. Your paper must be formatted in an 

author-date style, so use the styles manager to reformat the document with the APA 6th style or 

another author-date style.  

 

Click on the in-text citation you would like to edit so that it is highlighted. 

 

Click on the Edit & Manage Citation(s) button on the ribbon and the dialogue box will open. In the 

box labelled Prefix, type:  

 
see for example  

 

You must type a space after “example” to ensure that there is a space between the prefixed text and 

the citation in the document. Click on the OK button, and EndNote will reformat the citation with 

the prefixed text.  

 

As an example, see the first reference (Broadbent) below:  

 

 

We still know very little about how researchers in many areas identify the 

information resources that they need (see for example Broadbent, 1986). The 

available studies are often localised (Gould, 1988) or discipline-specific (Talja 

& Maula, 2003). There is a clear and pressing need for further research in this 

area, and a need for detailed longitudinal studies that will help to identify 

emerging trends. 

 

Budd pointed out many years ago that there are fundamental differences in the 

research cultures of the sciences and the humanities. There is nothing in the 

more recent literature to suggest that his findings have lost validity over the 

years. On the contrary, it may well be that recent technological developments 

have increased these differences (Guthrie, 2002). 

 

 

Works Cited 
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In-Text Citation with Prefixed Text 

Save this change to your document. 
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d. Adding Text after a Citation 
 

This is only applicable to author-date styles. 

 

Some styles allow you to add text after a citation. Normally this will be a specific page number. Your 

paper must be formatted in an author-date style. 

 

Click on the in-text citation you want to change so that it‟s highlighted.  

 

Click on the Edit & Manage Citation(s) button on the ribbon and the dialogue box will open. In the 

box labelled Suffix type:  
 p. 11 

You must type a space before “p.” to ensure that there is a space between the citation in the 

document and the suffix. Click on the OK button, and EndNote will reformat the citation with the 

text after the citation.  

 

As an example, see the second reference (Gould) below: 

 

 

We still know very little about how researchers in many areas identify the 

information resources that they need (see for example Broadbent, 1986). The 

available studies are often localised (Gould, 1988 p. 11) or discipline-specific 

(Talja & Maula, 2003). There is a clear and pressing need for further research 

in this area, and a need for detailed longitudinal studies that will help to 

identify emerging trends. 

 

Budd pointed out many years ago that there are fundamental differences in 

the research cultures of the sciences and the humanities. There is nothing in 

the more recent literature to suggest that his findings have lost validity over 

the years. On the contrary, it may well be that recent technological 

developments have increased these differences (Guthrie, 2002). 

 

 

Works Cited 
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In-Text Citation with Suffixed Text 

Save this change to your document. 
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Why can't I just enter the page number in the Pages box? 

 

When you click on the Edit Citations button, the dialogue box which appears has 

sections for Prefix, Suffix, and Pages. It seems logical to enter a page number in the 

Pages box. 

 

In earlier versions of EndNote, the Pages box was used only for footnote styles. It was 

not used for author-date styles such as APA or Harvard. In recent versions of EndNote, 

some author-date output styles (e.g. APA 6
th
) are configured so that you can simply 

enter a page number in the Pages box, and EndNote will format the reference and add 

all the necessary punctuation for you.  

 

 
e. Omitting Authors’ Names from Citations 
This is only applicable to author-date styles. 

Most style manuals insist that if you have mentioned the author‟s name in the text, you should drop 

the author‟s name from the citation, e.g.  

These results were confirmed by Smith (1993). 

This can easily be done with EndNote. 

When you first insert the reference, it will look something like this: 

These results were confirmed by Smith (Smith, 1993). 

To remove the author‟s name from the citation, click on the citation to highlight it, and then click on 

the Edit & Manage Citation(s) button on the ribbon.  

When the dialogue box opens, make sure the desired reference is highlighted and click on the drop-

down menu [Default]. Change the drop-down menu to Exclude author then click on the OK button. 

EndNote will remove the author‟s name from the citation.  

 
 

Save this change to your document. 
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f. Correcting Details in a Reference 

When you see the references formatted in your bibliography, you may notice errors that you made 

when entering the details in your EndNote library. To correct these errors, go back to your EndNote 

library, open the reference, and correct it. Then close the reference to save the changes. 

When you return to your Word document, you may find that the Instant Formatting function has 

already corrected the reference. However, in some cases you will find that the reference in your 

Word document has not been corrected. 

To correct the reference in your Word document, click on the Update Citations and Bibliography 

button      on the ribbon. EndNote will format the references again 

and the bibliography will be corrected. 

g. What is the “Traveling Library”? 

 
What is the "Traveling Library"? 

Although your document looks like a normal Word document, it is not. It contains 

field codes which include most of the data from your EndNote library (except the 

Notes, Abstract and Figure fields) relating to each of the references that you have 

cited. This stored reference data is called the Traveling Library. 

If you are collaborating with colleagues who also use a recent version of EndNote and 

a recent version of Word, you can send them your formatted Word document and they 

can add text and references to it from their own EndNote libraries. They can format the 

amended document because all data relating to your references are stored in the 

Traveling Library. 

Later on you may wish to copy your colleagues‟ references and add them to your own 

EndNote library. Use the Help in EndNote – look for the topic “Traveling Library 

(Word): exporting to EndNote”. 

Beware: When sharing documents with a colleague, your colleague must be using a 

compatible version of EndNote. Recent versions of EndNote are not compatible with 

EndNote 7 and earlier versions. 

 
h. Removing the Field Codes 

If you wish to submit your paper for publication, you must first remove all field codes, as they could 

interfere with the software used by the publisher.  

Go to the Convert Citations and Bibliography button on the ribbon and click on the arrow to select 

Convert to Plain Text: 

 

You will see a warning message, explaining that this will preserve your original document (with 

EndNote field codes) and create a new, unsaved document (without EndNote field codes). Click on 

the OK button to continue.  

Save the new document under a new name, and send that version for publication. 

Keep the original document, as that it is the master copy which you will have to use if you wish to 

add or remove any references using EndNote. 
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19. Useful Web Addresses 
 

UNE Library Endnote Site 

www.une.edu.au/library/support/endnote/index.php 

 Answers to frequently asked questions 

 Filters for UNE databases 
www.une.edu.au/library/support/endnote/filters.php 

 Australian styles 
www.une.edu.au/library/support/endnote/styles.php 

 Find out how to download Journal Term lists of abbreviations for medicine, biosciences, 

chemistry, anthropology, economics, humanities, philosophy, religion and zoology 
www.une.edu.au/library/support/endnote/journal_abbreviations.php 

 How to download from databases www.une.edu.au/library/support/endnote/downloads.php 

Official EndNote Site 

www.endnote.com/ 

 Updates and patches for EndNote software 
www.endnote.com/support/enupdates.asp  

 Answers to frequently asked questions 
www.endnote.com/support/faqs/index.asp  

 View or download video tutorials about using EndNote 
http://www.endnote.com/training/ 

 Extra filters to download 
www.endnote.com/support/enfilters.asp 

 Extra styles to download 
www.endnote.com/support/enstyles.asp 

EndNote Discussion Forums 

http://forums.thomsonscientific.com/ts/ 

 Communicate with other EndNote users 

 Search previous postings 

 Make suggestions for improvements to EndNote. 


